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Performing a Steady Flow Analysis 
 
 
   This chapter discusses how to calculate steady flow water surface profiles.   

The chapter is divided into two parts.  The first part discusses how to enter 
steady flow data and boundary conditions.  The second part discusses how to 
develop a plan and perform the calculations. 
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Entering and Editing Steady Flow Data 
 
   Once all of the geometric data are entered, the modeler can then enter any 

steady flow data that are required.  To bring up the steady flow data editor, 
select Steady Flow Data from the Edit menu on the HEC-RAS main 
window.  The steady flow data editor should appear as shown in Figure 7.1   

 
   Steady Flow Data 
 
   The user is required to enter the following information: the number of profiles 

to be calculated; the peak flow data (at least one flow for every river reach 
and every profile); and any required boundary conditions.  The user should 
enter the number of profiles first.  The next step is to enter the flow data.  
Flow data are entered directly into the table.  Use the mouse pointer to select 
the box in which to enter the flow then type in the desired value.   

 
   Flow data are entered from upstream to downstream for each reach.  At least 

one flow value must be entered for each reach in the river system.  Once a 
flow value is entered at the upstream end of a reach, it is assumed that the 
flow remains constant until another flow value is encountered within the 
reach.  The flow data can be changed at any cross section within a reach.  To 
add a flow change location to the table, first select the reach in which you 
would like to change the flow (from the river and reach boxes above the 
table).  Next, select the River Station location for which you want to enter a 
flow change.  Then press the Add Flow Change Location button.  The new 
flow change location will appear in the table. 
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  Figure 7.1  Steady Flow Data Editor 
 
 
   Each profile is automatically assigned a title based on the profile number, 

such as profile #1 is assigned a title of "Prof #1," profile #2 is assigned a title 
of "Prof #2," etc.  The user can rename the title for each profile by simply 
going into the options menu and selecting Edit Profile Names.  Once this 
option is selected, a dialog will appear allowing you to rename each of the 
profile titles. 

 
   Boundary Conditions 
 
   After all of the flow data have been entered into the table, the next step is to 

enter any boundary conditions that may be required.  To enter boundary 
conditions data, press the Boundary Conditions button at the top right of the 
steady flow data editor.  The boundary conditions editor should appear as 
shown in Figure 7.2.   

 
   Boundary conditions are necessary to establish the starting water surface at 

the ends of the river system (upstream and downstream).  A starting water 
surface is necessary in order for the program to begin the calculations.  In a 
subcritical flow regime, boundary conditions are only necessary at the 
downstream ends of the river system.  If a supercritical flow regime is going 
to be calculated, boundary conditions are only necessary at the upstream ends 
of the river system.  If a mixed flow regime calculation is going to be made, 
then boundary conditions must be entered at all ends of the river system. 
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  Figure 7.2  Steady Flow Boundary Conditions Editor 

 
 
   The boundary conditions editor contains a table listing every reach.  Each 

reach has an upstream and a downstream boundary condition.  Connections to 
junctions are considered internal boundary conditions.  Internal boundary 
conditions are automatically listed in the table, based on how the river system 
was defined in the geometric data editor.  The user is only required to enter 
the necessary external boundary conditions. 

 
   To enter a boundary condition, first use the mouse pointer to select the cell 

location in which you would like to enter a boundary condition.  Then select 
the type of boundary condition from the four available types listed above the 
table.  The four types of boundary conditions consist of: 

 
   Known Water Surface Elevations - For this boundary condition the user 

must enter a known water surface for each of the profiles to be computed. 
 
   Critical Depth - When this type of boundary condition is selected, the user is 

not required to enter any further information.  The program will calculate 
critical depth for each of the profiles and use that as the boundary condition. 

 
   Normal Depth - For this type of boundary condition, the user is required to 

enter an energy slope that will be used in calculating normal depth 
(Manning's equation) at that location.  A normal depth will be calculated for 
each profile based on the user-entered slope.  If the energy slope is unknown, 
the user could approximate it by entering either the slope of the water surface 
of the slope of the channel bottom. 

 
   Rating Curve - When this type of boundary condition is selected, a pop up 

window appears allowing the user to enter an elevation versus flow rating 
curve.  For each profile, the elevation is interpolated from the rating curve 
given the flow. 
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   An additional feature of the boundary condition editor is that the user can 
specify a different type of boundary condition for each profile at the same 
location.  This is accomplished by first selecting the option that says "Set 
boundary for one profile at a time" at the top of the window.  When this 
option is selected, the table will expand out to provide a row for each profile, 
at every location.  The user can then select the location and profile for which 
they would like to change the boundary condition type. 

 
   Once all the boundary conditions data are entered, press the OK button to 

return to the steady flow data editor.  Press the Apply Data button to have the 
data accepted. 

 
   Steady Flow Data Options 
 
   Several options are available from the steady flow data editor to assist users 

in entering the data.  These features can be found under the Options menu at 
the top of the window.  The following options are available: 

 
   Undo Editing.  This option allows the user to retrieve the data back to the 

form that it was in the last time the Apply Data button was pressed.  Each 
time the Apply Data button is pressed, the Undo Editing feature is reset to the 
current information. 

 
   Delete Row From Table.  This option allows the user to delete a row from 

the flow data table.  To use this option, first select the row to be deleted with 
the mouse pointer.  Then select Delete Row From Table from the options 
menu.  The row will be deleted and all rows below it will move up one. 

 
Delete All Rows From Table.  This option allows the user to delete all of the 
rows from the table.  To use this option, select Delete All Rows From Table 
from the Options menu.  When this option is selected a window will appear 
with a question to make sure that deleting all of the row is what you really 
want to do. 

 
   Delete Column (Profile) From Table.  This option allows the user to delete 

a specific column (profile) of data from the table.  To use this option, first 
select the column that you want to delete by placing the mouse over any cell 
of that column and clicking the left mouse button.   Then select Delete 
Column (Profile) From Table from the Options menus.  The desired 
column will then be deleted. 

 
   Ratio Selected Flows.  This option allows the user to multiply selected 

values in the table by a factor.  Using the mouse pointer, hold down the left 
mouse button and highlight the cells that you would like to change by a 
factor.  Next, select Ratio Selected Flows from the options menu.  A pop up 
window will appear allowing you to enter a factor to multiply the flows by.  
Once you press the OK button, the highlighted cells will be updated with the 
new values. 
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   Edit Profile Names.  This option allows the user to change the profile names 
from the defaults of PF#1, PF#2, etc. 

 
   Set Changes in WS and EG.  This option allows the user to set specific 

changes in the water surface and energy between any two cross sections in the 
model.  The changes in water surface and energy can be set for a specific 
profile in a multiple profile model.  When this option is selected, a window 
will appear as shown in Figure 7.3.  As shown, there are four options that the 
user can select from: Additional EG, Change in EG, Known WS, and 
Change in WS.  The Additional EG option allows the user to add an 
additional energy loss between two cross sections.  This energy loss will be 
used in the energy balance equation in addition to the normal friction and 
contraction and expansion losses.  The Change in EG option allows the user 
to set a specific amount of energy loss between two cross sections.  When this 
option is selected, the program does not perform an energy balance, it simply 
adds the specified energy loss to the energy of the downstream section and 
computes a corresponding water surface.  The Known WS option allows the 
user to set a water surface at a specific cross section for a specific profile.   
During the computations, the program will not compute a water surface 
elevation for any cross section where a known water surface elevation has 
been entered.  The program will use the known water surface elevation and 
then move to the next section.  The Change in WS option allows the user to 
force a specific change in the water surface elevation between two cross 
sections.  When this option is selected, the program adds the user specified 
change in water surface to the downstream cross section, and then calculates a 
corresponding energy to match the new water surface.   

 

 
 

  Figure 7.3  Setting Changes in Water Surface and Energy 
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   As shown in Figure 7.3, to use the "Set Internal Changes in WS and EG" 
option, the user first selects the river, reach, river station, and profile that they 
would like to add an internal change too.  Once the user has established a 
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location and profile, the next step is to select one of the four available options 
by pressing the appropriate button.  Once one of the four buttons are pressed, 
a row will be added to the table at the bottom, and the user can then enter a 
number in the value column, which represents the magnitude of the internal 
change. 

 
   Observed WS.  This option allows the user to enter observed water surfaces 

at any cross section for any of the computed profiles.  The observed water 
surfaces can be displayed on the profile plots and in the summary output 
tables. 

 
   Gate Openings.  This option allows the user to control gate openings for any 

inline  or lateral gated spillways that have been added to the geometric data.  
When this option is selected, a window will appear as shown in Figure 7.4. 

 

 
 

  Figure 7.4  Inline Spillway Gated Openings Editor 
 
 
   As shown in Figure 7.4, for each profile the user can specify how many gates 

are opened per gate group, and at what elevation they are opened too.  For the 
example shown in Figure 7.4, there are three gate groups labeled "Left 
Group," "Center Group," and "Right Group."  Each gate group has five 
identical gate openings.  All of the gate openings have a maximum opening 
height of ten feet.  For profile number 1, only the middle gate group is 
opened, with all five gates opened to a height of five feet.  For the second 
profile, all three gate groups are opened.  The Left gate group has two gates 
opened to seven feet, the Center gate group has five gates opened to four feet, 
and the Right gate group has two gates opened for seven feet.  This type of 
information must be entered for all of the profiles being computed. 

 
Optimize Gate Openings.  This option allows the user to have the program 
compute a gate setting at a structure in order to obtain a user specified water 
surface upstream of the structure.  Given a user entered flow and upstream 
stage for each profile, the program will iterate with different gate settings 
until the desired upstream water surface is obtained.  This option is very 
handy when modeling dams and reservoirs. 
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   Initial Lateral Split Flow Values.  This option allows the user to enter initial 
estimates of the flow that is leaving the main river through a lateral 
weir/spillway.  Flow values can be entered for each profile.  When a value is 
entered for this option, that amount of flow is subtracted from the main river 
before the first profile is computed.  This option can be useful in reducing the 
required computation time, or allowing the program to reach a solution that 
may not otherwise been obtainable. 

 
   Storage Area Elevations.  This option allows the user to enter water surface 

elevations for storage areas that have been entered into the geometric data.  
Storage areas are most often used in unsteady flow modeling, but they may 
also be part of a steady flow model.  When using storage areas within a 
steady flow analysis, the user is requires to enter a water surface elevation for 
each profile.  

 
   Saving The Steady Flow Data 
 
   The last step in developing the steady flow data is to save the information to a 

file.  To save the data, select the Save Flow Data As from the File menu on 
the steady flow data editor.  A pop up window will appear prompting you to 
enter a title for the data. 

 
   Importing Data From The HEC Data Storage System 

(HEC-DSS) 
 
   HEC-DSS is a data base system that was specifically designed to store data 

for applications in water resources.  The HEC-DSS system can store almost 
any type of data, but it is most efficient at storing large blocks of data (e.g., 
time-series data).  These blocks of data are stored as records in HEC-DSS, 
and each record is given a unique name called a "pathname."  A pathname 
can be up to 391 characters long and, by convention, is separated into six 
parts.  The parts are referenced by the letters A, B, C, D, E, and F, and are 
delimited by a slash "/" as follows: 

 
    /A/B/C/D/E/F/ 
 
   The pathname is used to describe the data in enough detail that various 

application programs can write to and read data from HEC-DSS by simply 
knowing the pathname.  For more information about HEC-DSS, the user is 
referred to the "HEC-DSS, User’s Guide and Utility Manuals" (HEC, 1995). 

       
   Many of the HEC application programs have the ability to read from and 

write to the HEC-DSS.  This capability facilitates the use of observed data as 
well as passing information between software programs.  The ability to read 
data from HEC-DSS has been added to HEC-RAS in order to extract flow 
and stage data for use in water surface profile calculations.  It is a common 
practice to use a hydrologic model (i.e., HEC-HMS) to compute the runoff 
from a watershed and then use HEC-RAS to compute the resulting water 
surface profiles.   
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   Reading data from HEC-DSS into HEC-RAS is a two-step process.  First, the 
user must establish connections between HEC-RAS cross-section locations 
and pathnames contained in the HEC-DSS file.  These connections are 
established by selecting the "Set Locations for DSS Connections" option 
from the File menu of the Steady Flow Data editor.  When this option is 
selected, a window will appear as shown in Figure 7.5.  The user selects 
cross-section locations for DSS connections by selecting a River, Reach, and 
River Station, then pressing the "Add selected location to table" button.  
When this button is pressed, a new row will be added to the table at the top of 
the window.  The user should do this for all the locations where they want to 
establish connections to HEC-DSS data.   

 
   The next step is to open a particular HEC-DSS file.  The user has the option 

of either typing the filename in directly, or using the open button, which is 
right next to the filename field.  Once a DSS file is selected, a listing of the 
pathnames for all of the data contained in that file will appear in the table at 
the bottom of the window.  The user can establish connections to more than 
one DSS file if desired. 

 

 
 

 Figure 7.5  Editor for setting connections to HEC-DSS pathnames. 
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   To establish the connection between an HEC-RAS cross section and a 
particular pathname in the DSS file, the user selects the row in the upper table 
that contains the river station that they want to connect data to.  Next, they 
select the pathname that they want to connect to that river station from the 
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lower table.  Finally, they press the button labeled "Select DSS Pathname," 
and the pathname is added to the table at the top of the window. 

 
   To make it easier to find the desired pathnames, a set of pathname part filters 

were added to the top row of the lower table.  These filters contain a list of all 
the DSS pathname parts contained within the currently opened DSS file.  If 
the user selects a particular item within the list of one of the pathname parts, 
then only the pathnames that contain that particular pathname part will be 
displayed.  These filters can be used in combination to further reduce the list 
of pathnames displayed in the table.  When a particular filter is left blank, that 
means that pathname part is not being filtered. 

 
   Another feature on the editor to assist in selecting the appropriate pathnames 

is the "Plot Selected Pathname" button.  This button allows the user to get a 
plot or a table of the data contained within any record in the DSS file.  The 
user simply selects a DSS pathname, and then presses the Plot Selected 
Pathname button, and a new window will appear with a graphic of the data 
contained within that record.   

 
   Once all of the pathname connections are set, the user presses the OK button 

to close the editor.  The next step is to import the data.  This is accomplished 
by selecting "DSS Import" from the File menu of the Steady Flow Data 
editor.  When this option is selected, a window will appear as shown in 
Figure 7.6 

 

 
 
   Figure 7.6  DSS Data Import Window 
    
 
   First the user sets a time window, which consists of a starting date and time 

and an ending date and time.  When data are extracted from DSS, the 
program will only look at the data that is contained within the user specified 
time window.  
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   Below the time window there are two options for selecting flow data to be 
extracted from the DSS file.  The first option allows the user to pick off flow 
data at a specified time interval, starting with the beginning of the time 
window for the first profile.  The second and subsequent profiles would be 
based on adding the user specified time interval to the start time of the time 
window.  Flow data is extracted from the hydrographs at each of the locations 
being read from DSS.  The second option listed on the window allows the 
user to get an overall peak flow for a profile computation.  When this option 
is selected, the peak flow will be extracted from each hydrograph, within the 
time window specified.  These peak flows will be made into the final profile 
in the flow data editor.   

 
   The bottom portion of the window contains options for interpolating flow 

data at locations that do not have hydrographs in the DSS file.  After the flow 
data are read in, it will be necessary to interpolate flow data at all of the 
locations listed in the flow data editor that do not have values in the DSS file.  
Three options are available: no interpolation, linear interpolation, or using the 
flow data from an existing profile to calculated ratios for interpolating 
between points that have data.  Once all the options are set, the user presses 
the "Import Data" button, to have the data imported and fill out the flow data 
editor. 

 
 

Performing Steady Flow Calculations 
 
   Once all of the geometry and steady flow data have been entered, the user can 

begin calculating the steady flow water surface profiles.  To perform the 
simulations, go to the HEC-RAS main window and select Steady Flow 
Analysis from the Run menu.  The Steady Flow Analysis window will 
appear as in Figure 7.7 (except yours may not have a Plan title and short ID). 

 

 
 
   Figure 7.7  Steady Flow Analysis window 
 
 
 

 7-10



Chapter 7  Performing a Steady Flow Analysis 
 

   Defining A Plan 
 
   The first step in performing a simulation is to put together a Plan.  The Plan 

defines which geometry and flow data are to be used, as well as provide a 
description and short identifier for the run.  Also included in the plan 
information are the selected flow regime and the simulation options. 

 
   Before a Plan is defined, the user should select which geometry and flow data 

will be used in the plan.  To select a geometry or flow file, press the down 
arrow button next to the desired data type.  When this button is pressed, a list 
will appear displaying all of the available files of that type that are currently 
available for the project.  Select the geometry and flow files that you want to 
use for the current plan. 

 
   To establish a Plan, select New Plan from the File menu on the steady flow 

analysis window.  When New Plan is selected, a window will appear 
prompting you to enter a title for the plan.  After you enter the title, press the 
OK button to close the window and accept the title.  The user will also be 
prompted to enter a short identifier for the plan.  The short identifier is limited 
to 12 characters.  It is very important to enter a short identifier that is 
descriptive of the plan.  When viewing multiple plan output from the graphics 
and tables, the Short ID will be used to identify each plan. 

 
   The last step is to select the desired flow regime for which the model will 

perform calculations.  The user can select between subcritical, supercritical, 
or mixed flow regime calculations.   

    
   Saving The Plan Information 
 
   To save Plan information to the hard disk, select Save Plan from the File 

menu of the simulation window.  Whenever options are changed or modified 
on the Steady Flow Analysis window, the user should Save the Plan. 

    
   Simulation Options 
 
   The following is a list of the available simulation options under the Options 

menu of the Steady Flow Analysis window: 
 
   Encroachments.  This option allows the user to perform a floodway 

encroachment analysis.  For a detailed description of how to use the floodway 
encroachment capabilities of HEC-RAS, see Chapter 9 of the User’s Manual 
(this manual).  For a description of how the encroachment calculations are 
performed for the various encroachment methods, see Chapter 9 of the 
Hydraulic Reference Manual. 

 
   Flow Distribution Locations.  This option allows the user to specify 

locations in which they would like the program to calculate flow distribution 
output.  The flow distribution option allows the user to subdivide the left 
overbank, main channel, and right overbank, for the purpose of computing 
additional hydraulic information.   
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As shown in Figure 7.8, the user can specify to compute flow distribution 
information for all the cross sections (this is done by using the Global option) 
or at specific locations in the model.  The number of slices for the flow 
distribution computations must be defined for the left overbank, main 
channel, and the right overbank.  The user can define up to 45 total slices.  
Each flow element (left overbank, main channel, and right overbank) must 
have at least one slice.  The flow distribution output will be calculated for all 
profiles in the plan during the computations.   

          

 
 
   Figure 7.8  Window for Specifying the Locations of Flow Distribution 
 
 
   To set the flow distribution option for all the cross sections, simply select the 

number of slices for the left overbank, main channel, and right overbank from 
the Set Global Subsections portion of the window.  To set flow distribution 
output at specific locations, use the Set Specific Location Subsection 
Distribution option.   

 
   During the normal profile computations, at each cross section where flow 

distribution is requested, the program will calculate the flow, area, wetted 
perimeter, percentage of conveyance, and average velocity for each of the 
user defined slices.   For details on how the flow distribution output is 
actually calculated, see Chapter 4 of the HEC-RAS Hydraulic Reference 
Manual.  For information on viewing the flow distribution output, see Chapter 
9 of the User’s Manual (this manual). 
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   Conveyance Calculations.  This option allows the user to tell the program 
how to calculate conveyance in the overbanks.  Two options are available.  
The first option, At breaks in n values only, instructs the program to sum 
wetted perimeter and area between breaks in n values, and then to calculate 
conveyance at these locations.  If n varies in the overbank the conveyance 
values are then summed to get the total overbank conveyance.  The second 
option, Between every coordinate point (HEC-2 style), calculates wetted 
perimeter, area, and conveyance between every coordinate point in the 
overbanks.  The conveyance values are then summed to get the total left 
overbank and right overbank conveyance.  These two methods can provide 
different answers for conveyance, and therefore different computed water 
surfaces.  The At breaks in n values only method is the default.   

 
   Friction Slope Methods.  This option allows the user to select one of four 

available friction slope equations, or to allow the program to select the 
method based on the flow regime and profile type.  The four equations are: 

 
    - Average Conveyance (Default) 
 
    - Average Friction Slope 
 
    - Geometric Mean Friction Slope 
 
    - Harmonic Mean Friction Slope 
 
   Set Calculation Tolerances.  This option allows the user to override the 

default settings for the calculation tolerances.  These tolerances are used in 
the solution of the energy equation.  Warning !!! - Increasing the default 
calculation tolerances could result in computational errors in the water 
surface profile.  The tolerances are as follows: 

 
   Water surface calculation tolerance:  This tolerance is used to compare 

against the difference between the computed and assumed water surface 
elevations.  When the difference is less than the tolerance, the program 
assumes that it has a valid numerical solution. 

 
   Critical depth calculation tolerance:  This tolerance is used during the critical 

depth solution algorithm. 
 
   Maximum number of iterations:  This variable defines the maximum number 

of iterations that the program will make when attempting to balance a water 
surface. 

 
   Maximum difference tolerance:  This tolerance is used during the balance of 

the energy equation.  As the program attempts to balance the energy equation, 
the solution with the minimum error (assumed minus computed water 
surface) is saved.  If the program goes to the maximum number of iterations 
without meeting the specified calculation tolerance, the minimum error 
solution is checked against the maximum difference tolerance.  If the solution 
at minimum error is less than this value, then the program uses the minimum 
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error solution as the answer, issues a warning statement, and then proceeds 
with the calculations.  If the solution at minimum error is greater than the 
maximum difference tolerance, then the program issues a warning and 
defaults the solution to critical depth.  The computations then proceed from 
there. 

 
   Flow Tolerance Factor:  This factor is only used in the bridge and culvert 

routines.  The factor is used when the program is attempting to balance 
between weir flow and flow through the structure.  The factor is multiplied by 
the total flow.  The resultant is then used as a flow tolerance for the balance 
of weir flow and flow through the structure.  

 
   Maximum Iteration in Split Flow:  This variable defines the maximum 

number of iterations that the program will use during the split flow 
optimization calculations. 

 
   Flow Tolerance Factor in Weir Split Flow: This tolerance is used when 

running a split flow optimization with a lateral weir/gated spillway.  The split 
flow optimization continues to run until the guess of the lateral flow and the 
computed value are within a percentage of the total flow.  The default value 
for this is 2 percent (.02). 

 
   Maximum Difference in Junction Split Flow:  This tolerance is used during a 

split flow optimization at a stream junction.  The program continues to 
attempt to balance flow splitting from one reach into two until the energy 
gradelines of the receiving streams are within the specified tolerance. 

 
   Each of these variables has an allowable range and a default value.  The user 

is not allowed to enter a value outside of the allowable range. 
 
   Critical Depth Output Option.  This option allows the user to instruct the 

computational program to calculate critical depth at all locations. 
 
   Critical Depth Computation Method.  This option allows the user to select 

between two methods for calculating critical depth.  The default method is the 
Parabolic Method.  This method utilizes a parabolic searching technique to 
find the minimum specific energy.  This method is very fast, but it is only 
capable of finding a single minimum on the energy curve.  A second method, 
Multiple Critical Depth Search, is capable of finding up to three minimums 
on the energy curve.  If more than one minimum is found the program selects 
the answer with the lowest energy.  Very often the program will find 
minimum energies at levee breaks and breaks due to ineffective flow settings.  
When this occurs, the program will not select these answers as valid critical 
depth solutions, unless there is no other answer available.  The Multiple 
Critical Depth Search routine takes a lot of computation time.  Since critical 
depth is calculated often, using this method will slow down the computations.  
This method should only be used when you feel the program is finding an 
incorrect answer for critical depth. 
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   Split Flow Optimizations.  This option allows the user to have the program 
optimize the split of flow at lateral structures, lateral diversions, stream 
junctions, and pump stations.  When this option is selected, a window will 
appear as shown in Figure 7.9.  As shown in Figure 7.9, there are four tabs to 
choose from.  One tab is for each of the following: Junctions; Lateral 
Weirs/Diversions; Reach-Storage Areas; and Pump Stations.   

 
   When the Lateral Weir/Diversion tab is selected, a table with all of the 

lateral weirs/spillways and rating curves defined in the model will be 
displayed.  To have the program optimize the split of flow between the main 
stream and a lateral weir/spillway (or rating curve), the user simply checks 
the column labeled “Optimize.”  If you do not want a particular lateral 
weir/spillway to be optimized, the user should not check the box.  For the first 
iteration of the flow split optimization, the program assumes that zero flow is 
going out of the lateral structure.  Once a profile is computed, the program 
will then compute flow over the lateral structure.  The program then 
iteratively reduces the flow in the main channel, until a balance is reached 
between the main river and the lateral structure.  The user has the option to 
enter an initial estimate of the flow going out the lateral structure.  This can 
speed up the computations, and may allow the program to get to a solution 
that may not have otherwise been possible.  This option is available by 
selecting “Initial Split Flow Values” from the “Options” menu of the Steady 
Flow Data editor. 

 

    
 
   Figure 7.9  Split Flow Optimization Window 
 
 
   When the Junction tab is selected, the table will show all of the junctions in 

the model that have flow splits.  To have the program optimize the split of 
flow at a junction, check the optimize column, otherwise leave it unchecked.  
Flow optimizations at junctions are performed by computing the water 
surface profiles for all of the reaches, then comparing the computed energy 
grade lines for the cross sections just downstream of the junction.  If the 
energy in all the reaches below a junction is not within a specified tolerance 
(0.02 feet), then the flow going to each reach is redistributed and the profiles 
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are recalculated.  This methodology continues until a balance is reached.   
 

When the Reach – Storage Areas tab is selected, a window will appear 
displaying all of the storage areas that are upstream boundaries to river 
reaches.  If optimization is set on the program will automatically compute the 
stage in the storage area based in the flow in the river reach. 
 
The final tab is for Pumps.  When this tab is pressed a table will appear 
showing all of the locations where pump stations are connected to the main 
rivers.  The user can then turn on optimization for the split of flow between 
the main river and the pump station. 

 
   Check Data Before Execution.  This option provides for comprehensive data 

input checking.  When this option is turned on, data input checking will be 
performed when the user presses the compute button.  If all of the data are 
complete, then the program allows the steady flow computations to proceed.  
If the data are not complete, or some other problem is detected, the program 
will not perform the steady flow analysis, and a list of all the problems in the 
data will be displayed on the screen.  If this option is turned off, data 
checking is not performed before the steady flow execution.  The default is 
that the data checking is turned on.    

 
   Set Log File Output Level.  This option allows the user to set the level of the 

Log file.  The Log file is a file that is created by the computational program.  
This file contains information tracing the program process.  Log levels can 
range between 0 and 10, with 0 resulting in no Log output and 10 resulting in 
the maximum Log output. In general, the Log file output level should not be 
set unless the user gets an error during the computations.  If an error occurs in 
the computations, set the log file level to an appropriate value.  Re-run the 
computations and then review the log output, try to determine why the 
program got an error. 

 
   When the user selects Set Log File Output Level, a window will appear as 

shown in Figure 7.10.  The user can set a "Global Log Level," which will be 
used for all cross sections and every profile.  The user can also set log levels 
at specific locations for specific profiles.  In general, it is better to only set the 
log level at the locations where problems are occurring in the computations.  
To set the specific location log level, first select the desired reach and river 
station.  Next select the log level and the profile number (the log level can be 
turned on for all profiles).  Once you have everything set, press the Set button 
and the log level will show up in the window below.  Log levels can be set at 
several locations individually.  Once all of the Log Levels are set, press the 
OK button to close the window. 

 
   Warning !!! - Setting the log output level to 4 or 5 can result in very large log 

file output.  Log level values of 6 or larger can result in extremely large log 
files. 

 
   View Log File.  This option allows the user to view the contents of the log 

file.  The interface uses the Windows Write program to accomplish this.  It is 
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up to the user to set an appropriate font in the Write program.  If the user sets 
a font that uses proportional spacing, the information in the log file will not 
line up correctly.  Some fonts that work well are: Line Printer; Courier (8 pt.); 
and Helvetica (8 pt.).  Consult your Windows user's manual for information 
on how to use the Write program. 

 
 

 
 
   Figure 7.10  Log File Output Level Window 
 
 
   Starting the Computations 
 
   Once all of the data have been entered, and a Plan has been defined, the 

steady flow computations can be performed by pressing the Compute button 
at the bottom of the steady flow simulation window.  Once the compute 
button is pressed, a separate window will appear showing you the progress of 
the computations.  The information that appears in the window is only there 
as an indicator of the programs progress during the computations.  This 
window is not intended to be used for viewing any output.  When the 
computations have been completed, the user can close the computations 
window by clicking the close button at the bottom of the window.  If the 
computations ended with a message stating "Finished Steady Flow 
Simulation," the user can then begin to review the output. 

 7-17


	Performing a Steady Flow Analysis
	Entering and Editing Steady Flow Data
	Steady Flow Data
	Boundary Conditions
	Steady Flow Data Options
	Saving The Steady Flow Data
	Importing Data From The HEC Data Storage System (HEC-DSS)

	Performing Steady Flow Calculations
	Defining A Plan
	Saving The Plan Information
	Simulation Options
	Starting the Computations



